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 Welcome  

 
 

Welcome to Weather Data Transfer Utility for Envoy8X, the solution for logging 

data from up to eight Davis weather stations, simultaneously. 

Envoy8X can log data from any of these Davis transmitting stations: Vantage 

Vue®, Vantage Pro2 ™, Vantage Pro2™ Plus, Weather Envoy for Vantage  

Pro2 ™, Anemometer Transmitter Kit, Wireless Leaf & Soil 

Moisture/Temperature, Wireless Temperature, and Wireless 

Temperature/Humidity.  It is compatible with the Universal Anemometer 
Interface and all Davis repeaters.  

Weather Data Transfer Utility for Envoy8X Features 

 Allows you to choose to see data from some or all sensors on the 

browser. 

 Allows you to export your data to an Excel spreadsheet. 

 "Listens" to 8 different transmitting stations, in any combination, even 8 

Integrated Sensor Suites. 

 Exports data to WeatherLink. 

 Archives your weather data at user-selectable intervals ranging from 10 

seconds to 2 hours.  

 32 times more memory than Weather Envoy. 

 Raw signal support allows for use with third party sensors. 

Note: Some listed features may require optional software or hardware.  
 
WeatherLink, Vantage Pro, Vantage Vue, Envoy8X and Weather Envoy are trademarks of Davis Instruments. 

Windows®, Vista® , and SQL Server®, are trademarks of Microsoft Corporation in the US and other countries. 

MySQL® is a trademark of Oracle Corporation. All other trademarks are the property of their respective owners. 
 

What’s New in this Version 
 

Version 1.2 

 
 Fixed temperature readings from Leaf & Soil stations for alarms. The 

temperature will be displayed in the user's preferred units (°C or °F). 
 

 
Version 1.1 

 
 Ability to configure and run automatic downloads added. 

 When using a MySQL database, the password field in the database 

connect form may be left empty. 

 Users now set preferred units before setting up the barometer in the 

setup process to allow for barometer units to be specified before setup. 

 Users can now view an event log for use in troubleshooting by selecting 

"Open Event Log" in the View menu. 
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 Getting Started  

 
 

 
Note: For best results using Windows Vista® or above, you should run the 

program as Administrator. (To do this, launch the program using right click, 

choose Run as Administrator; or see your OS Help.) 

 

The first time you run the Weather Data Transfer Utility for Envoy8X, you will 

be prompted to set up your database. The program uses MS Access as the 

default database (included with the software), but you can also use MySQL® or 

Microsoft SQL Server®. (These must be installed separately.) 

When you have finished setting up the database, you will be asked if you want 

to add a  new receiver. Click Yes and you will be guided through the setup.  

 

When you have finished adding the new receiver, the Main Screen will open. 

 

You can add new receivers at any time by clicking Add New Receiver in the 

Setup menu. 

 

Two appendices are also available.  Appendix A: Weather Data, is a reference 

for weather terms and data.  Appendix B: Specifications gives specification 

information for the Envoy8X. 

 

 

Short Glossary of Terms: 
 

Sensors: The parts of your weather station that measure or detect physical 

quantities (such as temperature, pressure, speed, direction) and convert it into 

an electronic signal, such as voltage. 

 Examples of Davis Sensors: 

 Temperature/Humidity sensor 

 Anemometer 

 Barometer 

 Rain collector 

 Temperature Probe 

 Leaf Wetness sensor 

 Soil Moisture sensor 

 

 

Transmitter or Transmitting Station: The part (or parts) of your weather 

station that wirelessly transmits the data, in the form of radio waves from an 

antenna. (In cabled systems, transmitters send a RS485 signal down a cable.) 

 
Transmitter ID (TX ID): Each transmitter in your system should be set up 

with a unique Transmitter ID, from 1 (factory default) to 8, which identifies it 

to the receiver. 

Examples of Davis Transmitters 

 Vantage Pro2, Pro2 Plus or Vantage Vue Integrated Sensor Suite 

 Anemometer/Sensor Transmitter Kit 

 Wireless Leaf Wetness & Soil Moisture/Temperature Station 

 Wireless Temperature/Humidity Station 

 Wireless Temperature Station 

Note: In a Vantage Pro2 or Vantage Vue system, the sensors and transmitters 

are combined into the outdoor Integrated Sensor Suite (or ISS). 
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Repeater: (Optional) A transceiver device used to extend the range of a 

transmitting station. 

Examples of Davis Repeaters: 

 Standard Repeater 

 Long Range Repeater  

 

 

Receiver: The part of your station that converts the radio signal into usable 

information. Receivers with an LCD screen also display the information. (In 

cabled systems, receivers are not radio receivers.) 

Examples of Davis Receivers: 

 Envoy8X 

 Weather Envoy (not compatible with this software) 

 Vantage Pro2 or Vantage Vue console (not compatible with this 

software) 

Note: A Vantage Pro2 or Vantage Vue console can also be set to retransmit. 

 
 

Data Logger: The part of your weather station that records and stores data 

over time. We refer to this memory as archive memory. Davis data loggers are 

part of the WeatherLink package and can be installed in any receiver.  In the 

Envoy8X, the archive memory is built into the unit, however a data logger is 

still required to facilitate communication with the computer. 

 

 

Software:  Computer programs that take the weather data stored in the data 

logger and present or store it for use as archives, graphs, analysis and other 

reports and special usage. 

Examples of Davis Software: 

 Weather Data Transfer Utility for Envoy8X 

 WeatherLink 
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 Database Setup  

 
 

The first time you use Weather Data Transfer Utility for Envoy8X, you will be prompted to 

set up your database for the software to use. 

The Database Setup Screen will display: 

  

You may select Express database setup or Custom database setup. 

 

Choose Express setup to have the software create a Microsoft Access database in the 

program's default location (the Weather DTU installation location). 

Choose Custom setup to have the software connect to a MySQL or MS SQL Server 

database or set up an Access database in another directory. Click OK to open the 

Database Connection dialog. This dialog allows you to select which database to connect 

to. 

 

For help with this step, see Choosing Your Database. 

Note: You may change database type selection at any time from Database menu.  Select 

Connect To Database. Select the database type in the Database Type drop-down list. 

(Based on the database type selected, database connection information needed for that 

type will be shown.) 
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 Choosing Your Database  

 
 

Weather Data Transfer Utility for Envoy 8X supports three different database types: MS 

Access, MS SQL Server and MySQL.   

 

Single-User Database: 

 MS Access (Microsoft Access) 

Of the supported databases, MS Access is the easiest to use. There is no additional 

software to buy if you use MS Access.  

Note: MS Access has limitations on the number of users connected simultaneously to 

the database, the size of the database, and reliability of the database. 

The maximum database size for MS Access is 2 gigabytes. If you log the weather data 

frequently, the database size increases rapidly. If you use MS Access and log 

frequently, you should  backup your data at least once a month. 

An MS Access database needs to be compacted on a regular basis to maintain proper 

performance and prevent the database from becoming too big. Weather DTU will 

automatically compact the Access database when you exit the software. For this 

reason, it is a good practice to close Weather DTU regularly to allow the Access 

database to be compacted and repaired.  (If the database size is so large that 

compacting will take some time, a message will appear allowing you to choose Yes or 

No to compacting.) 

 

Multi-User Databases: 

MySQL and MS SQL Server database servers are very powerful databases, which can support 

large amounts of data and multiple simultaneous connections with good performance.  

 MySQL 

 

MySQL is a database server developed by a company named MySQL AB as an Open 

Source Project. It is considered to be fast, stable, less expensive relatively easy to 

setup compared to database servers like MS SQL Server.  

 

Note: There is a free version of MySQL available for download on the MySQL web site. 

 

 MS SQL Server (Microsoft SQL Server) 

 

MS SQL Server is a powerful database server from Microsoft. It is also easy to setup, 

but MS SQL Server is more expensive than MySQL. 

Note: If you choose MySQL or MS SQL Server, we recommend that you have IT 

personnel who have the knowledge to maintain these database servers. 
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 Main Screen  

  
 

The Weather Data Transfer Utility for Envoy8X provides a dynamic browser on the main 

screen.  

 

From here, you can see your receivers and transmitters and can choose which data to view by 

sensor and Transmitter ID (TX ID).   

 

 
 

1. Menu Commands 

2. Highlight shows which device's data is being displayed. 

3. Data from highlighted transmitter(s) is displayed. The data in each column is from the 

sensor identified by Transmitter ID. (In this example, the data in the third column is from 

the anemometer on the Vantage Vue ISS, which is identified as Transmitter 1.  The wind 

data in the sixth column is from the Vantage Pro2 Plus ISS, identified as Transmitter 3.) 

4. Set custom dates for display in the browser. The default date is the most recent date on 

which data was downloaded from the selected transmitter; if no data has been 

downloaded, the default is today. 

5. Choose to include all dates and/or all transmitters. (Note that this will increase the refresh 

time, depending on how much data is stored.) 

6. Use the Select Data Fields button, or the command in the View pull-down menu, to 

choose which data fields to display. 

7. Refresh the screen using this button, or the command in the View pull-down menu. 

8. Click the Export to Excel button to export all the data shown in the browser to an Excel 

file. 

9. Delete Records deletes a row or rows selected in the browser. (Deletes the whole row, 

cannot be used to delete records in a single cell.) 

10. Data display area. The data displayed is from the device highlighted. 

 

Note: The buttons on this screen control only what is shown in the browser.  

 

Back to Getting Started 
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 Using Help  

 
 

Click Help or press F1 to access this document.  

 

 
 

 
The Help menu command or F1 key opens and displays the left-hand Contents Tab and Help 

Home Page.  

You may also use the Help Index and search features.   

If a Help button or ? button appear on any dialog box, use it to get more information about 

that dialog box, or press F1. 

 

 

 

Click About Weather Data Transfer Utility in the Help menu to see software version, 

firmware version of connected Envoy8X, copyright and other information. 

 

You may also find answers in the Troubleshooting Guide.   
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 Menu Commands  

 
 

Click on a topic below to view help for the indicated Weather Data Transfer Utility menu bar: 

 

Setup 

File 

View 

Database 

Help 
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 Setup  

 
 

Use the Setup Menu to configure the transmitting stations and sensors, set time and units, 

calibrate rain and wind readings, set alarms, and create or modify WeatherLink export profiles.   

 

 
 

Add New Receiver 

Communication Port 

Set Units 

Receiver Configuration 

Set Date & Time 

Set Archive Interval 

Clear Archive Memory 

Set Download Speed 

Set Barometer 

Rain Collector Increment 

Wind Cup Size 

Wind Direction Calibration 

Temperature Calibration 

Humidity Calibration 

Set Alarms 

Configure Automatic Download 

WeatherLink Export Profile 
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 Add New Receiver  

  
 

The Weather Data Transfer Utility software includes a walkthrough that steps you through the 

steps to set up and configure your Envoy8X receiver. If there are no Envoy8X receivers 

already set up, you will be prompted to add a new receiver when the program starts.  

 

You can set up and configure your receivers by separately selecting all of the necessary setup 

options from the Setup menu, at any time. The Add New Receiver option in the Setup 

menu allows you to access the receiver setup walkthrough at any time. 

The Envoy8X is a radio receiver designed to listen to up to 8 Davis transmitters in the field.  

A transmitting station can be any one of the following: 

 Vantage Pro2 ISS: Vantage Pro2 Integrated Sensor Suites: product numbers 

6152/6322, 6153/6323 

 Vantage Pro2 Plus ISS: Vantage Pro2 Plus Integrated Sensor Suites: product 

numbers 6162/6327, 6163/6328 

 Vantage Vue ISS: Integrated Sensor Suite, product number 6250/6357 

 Leaf/Soil Moisture: Wireless Leaf & Soil Moisture/Temperature Station, product 

numbers 6345 & 6345CS 

 Temperature/Humidity: Wireless Temperature/Humidity Station, product number 

6382 

 Temperature: Wireless Temperature Station, product number 6372 

 Wind: Anemometer/Sensor Transmitter Kit with Anemometer, product numbers 6332 

and 6410 

 Rain: Anemometer/Sensor Transmitter Kit with Rain Collector, product numbers 6332 

and 7852 

 Leaf/Soil Raw Signals: Third-party sensors (See Raw Data Inputs.) 

 Vantage Pro2 ISS Raw Signals: Third-party sensors (two voltage inputs) (See Raw 

Data Inputs.) 

 

Before you installed your Envoy8X and its software, you should have already installed any 

transmitting stations you want it to "listen" to. When you installed each of the transmitting 

stations, you should have set the Transmitter ID to a unique ID from 1 to 8.  (Stations come 

with a factory-set default Transmitter ID of 1. To change the Transmitter ID, see the manual 

that came with your transmitting stations.  Manuals are also online at davisnet.com.) In the 
next screen, you will specify which station is "broadcasting" on each Transmitter ID. 

1. The Add New Receiver menu command opens a dialog box that makes sure your 

receiver is connected to a COM Port. If the receiver is connected to the port used the 

last time you configured a receiver, the Add New Receiver dialog will appear.  

Otherwise the Communication Port dialog box will appear to allow you to change 

the port. 

2. Click Set to continue. In the next screen, you will specify which station is 

"broadcasting" on each Transmitter ID. 

 

Note: You can add transmitting stations at any time.  Once the new station is installed 

and set to an unused Transmitter ID number, click Receiver Configuration in Setup to 
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add the transmitter.  Remember to download data first, as reconfiguring the 

Envoy8X with a new station requires the archive memory in the data logger 

to be erased. 
 

3. The Add New Receiver dialog box appears.   

 

 
 

Receiver ID:  This ID number is automatically assigned to your Envoy8X receiver.  

You can change it to any number you like, or keep the default ID number.  

 

Receiver Name: Enter a name for this Envoy8X that you choose, such as "John's 

Envoy8X" or "Field 10."  If you plan to add other receivers, this name will make it 

easier to keep track of the devices. 

4. Configure the Transmitters: 

 

TX ID and Transmitter Type: Refer to the table you filled in with Transmitter IDs 

when setting up your transmitting stations.  For each Transmitter ID ("TX ID"), use 

the pull-down menu to specify what kind of transmitting station has been configured 

to transmit on that ID.  If there is no transmitting station with a particular Transmitter 

ID, leave the "Station Type" set to "Off" for that ID.  

 

Repeater: If any transmitting station is transmitting via a repeater, indicate the 

Repeater ID (A -H) that is nearest to and the last in the chain from the transmitter to 

your device. 

 

Transmitter Name:  You may assign a name to each Transmitter ID or accept the 

default, which is the station type, automatically preceded by the receiver name and 

followed by the Transmitter ID number.  Each transmitter reporting to the same 

receiver must have a unique name. 

 

For example, if all your transmitters are different types, then the default (such as 

"Field 10/Vantage Vue ISS_1" and "Field 10/Vantage Pro2 ISS_3") would be fine.   

 

If some of your transmitter types are the same, you may want to give them unique 

names to set them apart (such as "Field 10/Upper Leaf/Soil Moisture_1" and "Field 

10/Lower Leaf/Soil Moisture_3"). 



 13 

 

Archive Interval:  The default is set at 30 minutes.  To change this, use the pull-

down menu to choose 10, 15, 20, or 30 seconds; 1, 5, 10, 15, or 30 minutes; or 1 or 

2 hours.  Since a more frequent archive interval will write more data to memory, the 

Days of Storage will indicate how many days of data the logger can store in its 

archive memory, at that interval, before being overwritten.  Consider how often you 

will be downloading data, as well as how often you want data to be archived, when 

you set the archive interval. 

 

Log Inside Data: The Envoy8X houses not only the data logger, but also inside 

temperature and humidity sensors and barometer.  If you would like to log inside data 
reported by these sensors, check the Log Inside Data box.   

5. When you have finished configuring this receiver, click Set.  If you wish to start over, 

click Clear to clear all the values you have entered. To exit the Add New Receiver 

walkthrough, click Cancel, then click Yes when you are asked to confirm quitting. You 
can also skip any step by clicking No in the step's message box. 

  

Back to Getting Started 

Back to Setup 
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 Raw Data Inputs  

  
 

The Envoy8X can log data from third-party sensors that report in a range of 0 - 3 volts.  You 

will use the Raw Data Inputs screen to tell the software what kind of sensor, its reporting 

units and the ranges of data and voltage.  This information can be obtained from the 

manufacturer of the sensor. 

 

To add a third-party sensor: 

 
1. Use the Receiver Configuration or Add New Receiver menu command.  The 

configuration screen appears.   Choose either "Leaf/Soil Raw Signals" or "Vantage Pro2 

ISS Raw Signals" from the pull-down menu for that Transmitter ID, depending on which 

type of transmitter in which the sensor is installed. 

 

 

 
2. The Raw Data Inputs screen appears. For each input into which a sensor is plugged, 

enter a label, the units, and the ranges for the input. In the example below, a PAR 

Light sensor, which reports 400 to 700 nanometers, has been plugged into the UV 

sensor input of a Vantage Pro2 ISS. 

 

 

 

In the example below, the sensor is a snow depth indicator that reports from 1 to 20 

feet of snow depth and has been plugged into the first Leaf Wetness sensor input of 

Leaf Wetness/Soil Moisture station.   
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Note: Some application engineering may be necessary to determine into which input a 

sensor should be plugged. 

 
3. Click OK to save, Clear All to clear any entries, or Cancel to exit without saving. 

 

 
Back to Add New Receiver 

Back to Receiver Configuration 
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 Communication Port  

 
 

The Communication Port dialog box in the Setup menu allows you to specify the 

communications port used to connect each Envoy8X to the Weather Data Transfer 

Utility software.  To configure your communication port, select Communication Port 

from the Setup menu. 

 

1. The Setup Communication Port dialog box appears. 

 

 
 

2. Select the communication port that connects your Envoy8X to the computer 

from the COM Port pull-down menu.   

If you are not sure which to choose, click Auto Detect to let the software detect 

the correct port.  

If you are using a serial port and are not sure which serial port your console is 

connected to, or if you want to test that the port works correctly, use the 

Loopback device, included with WeatherLink-Serial version and the Loopback 
button. 

3. Click Test to verify the connection. The software checks the connection and lets 

you know if it is successfully connected to your Envoy8X. 

4. Once the communication port settings are correct, click OK to save the correct 
communication port settings; or Cancel to exit without saving. 

 
Back to Setup 
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 Set Units  

 
 

Select the units of measure in which data is displayed within the software.  

 

 

1. Select Set Units from the Setup menu. 

2. Select the desired units of measure: 

 

Temperature: 

Fahrenheit (°F) or Celsius (°C) 

Note: Wind chill, dew point, and heat indexes are all displayed in the same unit 

of measure as temperature. 

 

Barometer: 

Inches of Hg (in), Millimeters of Hg (mm), Millibars (mb), or Hectopascals (hPa) 

 

Wind Speed: 

Miles per hour (mph), knots (knot), kilometers per Hour (km/hr), or meters per 

second (m/s) 

 

Rain: 

Inches (in) or Millimeters (mm) 

 

Elevation: 

Feet or Meters 

 

Date Format: 

Year-Month-Day (2011-01-31) 

Month-Day-Year (01-31-2011) 

Day-Month-Year (31-01-2011) 

 

Time Format: 
12-hour or 24-hour 

3. After selecting units of measure, click Set. The software saves your choices. All 

information is displayed in the units of measure you selected. 
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 Receiver Configuration  

  
 

You can add, delete, or reconfigure transmitting stations at any time. To add a new 

transmitting station, (make sure it has been installed in the field and set to an unused 

Transmitter ID number), change or delete any transmitters already entered, click Receiver 

Configuration in the Setup menu.  

 

Note: Remember to download data before reconfiguring the Envoy8X, as reconfiguring 

requires the archive memory in the data logger to be erased. 

 

 
 

See Add New Receiver and Raw Data Inputs for more help with this menu command. 

Click Set to save your changes; Clear to reset all values to defaults, or Cancel to exit 

without saving changes. 

Back to Setup 
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 Set Date & Time  

 
 

You can set the time and date on your Envoy8X at any time.  Upon first power up, the 

time will not be current, so you will be prompted to set it.  At any other time, you may 

set or change the time of your Envoy8X. You should make sure that both Envoy8X and 

computer display the same time and date.  

 

Note: When you set the time to one earlier than what is currently set in the receiver, the 

archive memory will be cleared.  You should download data before changing time to 

avoid losing any data in the data logger.  

 

1. Select Set Time & Date from the Setup menu. 

 

The Set Time & Date dialog box displays. The time and date currently set in the 

Envoy8X appear at the top of the dialog box. The software automatically displays 

the current computer time and date in both the text boxes labeled Receiver 

Clock Time and Set to:.  If you are happy with the computer date and time for 

your receiver, skip to step 3. 

 

 
 

2. If you want the time and date to be different from that displayed in the "Set to" 

box, click on the number you want to change to select it and type in the new 

number.  Click the calendar icon to bring up a calendar if you would prefer to 

choose a day (including "Today") from the calendar. 

3. If you want the Envoy8X to automatically detect Daylight Saving Time, click Auto 

Detect.  (Make sure your time zone and latitude/longitude are correct.) 

 

Note: If you are in a time zone with a negative offset from UTC (North America) 

then daylight saving starts on the second Sunday in March at 2:00 am.  Daylight 

saving in a time zone with a negative offset ends on the first Sunday in 

November. 

 

You can manually select daylight saving time by selecting On when daylight 
saving time is in effect and selecting Off when standard time is in effect.  

4. Select your local time zone from the list. Time zones are defined by the number 
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of hours the local time is offset from Greenwich Mean Time (GMT).  

5. Enter your latitude and longitude. Latitude and longitude together comprise a 

spherical grid that allows pinpointing positions on the earth. For example, Davis 

Instruments' Hayward, California, factory is located at 37º 38' 10" North latitude, 

(or 37.4), and 122º 07' 30" West longitude, (or -122.1).  

 

Note: When directional designators are omitted, such as in this software, 

southern latitudes and western longitudes are given negative values.  

 

You can find your latitude and longitude in a variety of sources. You can use a 

geographical atlas to estimate your position, of course, but it's easier to use the 
world wide web.  

6. Click Set to save changes, or Cancel to exit without saving changes. 

Note: To change the time or date format (for example from 12-hour to 24-hour, or from 

MM-DD-YYY to DD-MM-YYYY), click Set Units in the Setup Menu.  

Back to Setup 
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 Set Archive Interval  

 
 

The Set Archive Interval option in the Setup menu allows you to select the time 

interval the data is stored onto the data logger's archive memory. The choices in the 

pull-down menu are: 10, 15, 20, or 30 seconds; 1, 5, 10, 15, or 30 minutes; or 1 or 2 

hours. This interval is known as the archive interval. 

 

Caution: Changing the archive interval from minutes to seconds or seconds to minutes 

requires the data logger archive memory to be cleared. You should download data 
before changing archive interval. 

1. Select Set Archive Interval from the Setup menu. 

 

 

2. Select the desired archive interval and click Set. If you have changed the 

archive interval from seconds to minutes or minutes to seconds, the software 

warns you that it is about to clear the archive memory. Click Cancel to exit 

without saving changes. 

 

Back to Setup 
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 Clear Archive Memory  

 
 

The archive memory is the weather information storage area, built into the Envoy8X. At 

each archive interval, the Envoy8X stores one record to archive memory.  

 

If you want to clear the data in the archive memory, click Clear Archive Memory in the 

Setup Menu. 

 

A confirmation message box appears. 

 

 
 

Click Yes to clear, or No to exit without clearing. 

 

Note: When the archive memory fills to capacity, the logger overwrites old data each 

time it stores a new record. Because of this, it’s best to choose the longest archive 

interval that suits your purpose. In addition, make sure to download data before your 
archive memory fills or you will have gaps in your database. 

Note: The software may need to clear an archive memory when changes are made to the 

configuration of the transmitting stations or to the time and date.  It will give you a 

warning before clearing.  If you do not want to lose the data, click Cancel when the 

warning appears, download the data, then repeat the procedure that initiated the archive 
memory clearing. 

Back to Setup 
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 Set Download Speed  

 
 

The software's default download speed is High (115,200 bps).   

 

1. To change the download speed, click on Set Download Speed in the Setup 

Menu. If your connection is slower, select Low Speed. 

 

 
 

 
2. Click Set to save the settings, or Cancel to exit without saving. 

 

Back to Setup 
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 Set Barometer  

 
 

1. Enter the elevation of your Envoy8X. 

 

The barometer is housed in the Envoy8X, so in order to get accurate barometric 

pressure data; as well as for ET and THSW Index calculations to work correctly, 

you need to specify the elevation of your Envoy8X. If you don’t know your 

elevation, there are many ways to find out. For example, you can try calling the 

reference desk at your local library, look up your town in an almanac, try calling 

a local airport, search the Internet or use Google Maps (in "terrain" view). In the 

USA, you can look for a United States Geological Survey topographical map of 

your area. 

 

Another way to find your elevation is to download Google Earth. 

 

Tip: Of course, the more accurate your elevation is the better, but it should be 

within 10' (3 m).  Don't forget to consider the floor the Envoy8X is on.  If your 

Envoy8X is in your office on the 5th floor of a building, you will need to add that 

elevation as well. 

 

 
 

2. Optional: Enter the correct sea-level barometric pressure. 

For the most accurate barometer readings, enter a Sea-level Barometer 

pressure from a reliable nearby reference. The Envoy8X uses this value to fine-

tune its own adjusted barometric pressure calculations.  

 

Note: Enter this only if you have a current reading from a very reliable nearby 

reference.  If you leave the Sea-Level Barometric pressure blank, the Envoy8X 
will report the pressure reading altered by the station elevation only.  

3. Click Set to save or Cancel to exit without saving. 

 

Back to Setup 
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 Set Rain Collector Increment  

 
 

Your Davis rain collector reports rain by increments of either 0.01 inches or 0.2 mm. 

Use this function to make sure the Envoy8X rain increment matches your rain 

collector. 

 

1. Select Set Rain Collector Increment from the Setup menu. The Rain 

Calibration dialog box displays.   

 

 
 

 

Note: Only TX IDs that have an ISS or a rain collector will be available to 

change.  

 

2. Select the correct increment from the pull-down list. 

3. Click Set to save the settings, or Cancel to exit without saving. 

 

Back to Setup 
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 Wind Cup Size  

 
 

Wind cup size -- small, large, or other -- is automatically set to the default for each 

type of transmitter. 

The default sizes are: 

 Vantage Vue ISS: Other 

 Vantage Pro2 or Pro2 Plus ISS: Large 

 Anemometer Transmitter Kit ("Wind"): Large 

 

If your wind cups are different from these defaults, you must set the Envoy8X to 

match. 

 

1. Select Wind Cup Size from the Setup menu.  

 

 
 

 

Note: Only TX IDs that have an ISS or an Anemometer Transmitter Kit 

("Wind") will be available to change.  

 

2. Select the correct wind cup size on your anemometer from the pull-down 

menu 

 

3. Click Set to save the settings, or Cancel to exit without saving. 

 

Note: If you use the Receiver Configuration screen, the default setting will be 

restored. 

 

Back to Setup 
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 Wind Direction Calibration  

 
 

Davis anemometers are calibrated at the factory to be accurate when installed as 

directed.  For the Vantage Pro2, the wind direction is calibrated to be accurate when the 

anemometer arm is pointing true north.  For the Vantage Vue, the wind direction is 

accurate when the solar panels are facing south.   

Note: Calibration should be done with the anemometer or ISS mounted in its final 

position. 

Vantage Pro2 or Anemometer Transmitter Kit: If your anemometer arm aims true 

north, simply click Set to skip without entering anything in the Desired Reading column. 

 

 

Vantage Vue: If ISS is mounted so that the solar panels face south, simply click Set to 

skip without entering anything in the Desired Reading column. 

 
 

 

If your anemometer or ISS is not mounted as directed, you must calibrate the Envoy8X 

by observing the wind vane to determine the actual wind direction (or, if no wind, the 

direction the vane pointing) to determine the desired reading; and then compare this 

reading to the Envoy8X's current reading.  

Tip: Remember, wind direction indicates where the wind is coming from. The nose of the 

wind vane points into the wind. 

Note: To use this method, you will need to either do this calibration when there is no 

wind, or when you can stabilize the vane so it doesn't move before you can calibrate the 

reading in the software.  If this is impractical, see the alternate method below. 
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1. Select Wind Direction Calibration from the Setup menu. The Wind Direction 

Calibration screen displays. 

 

 
 

 

Note: Only TX IDs that have an ISS or an Anemometer Transmitter Kit ("Wind") 

will be available to change. 

 

2. Enter the desired reading; that is, the true wind direction.  The software will 

automatically calculate the calibration. 

3. Click Set to save the settings, or Cancel to exit without saving. 
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Alternate Method:  

If it is impractical to observe the vane when there is no wind, or to stabilize the vane, 

you can also determine how far "off" the anemometer is mounted, and add or subtract 

the number of degrees the anemometer is "off" to the current reading to get an the 

desired reading.  Use a compass, and this diagram, if necessary to determine this 

number. 

 

First determine what direction your anemometer arm for Vantage Pro2, or the solar 

panel for Vantage Vue, is actually pointing.  Imagine rotating the compass below so that 

the arm (Vantage Pro2) points to 0o or so that the solar panel (Vantage Vue) points to 

180o: a clockwise rotation will require you to calibrate by adding degrees; counter-

clockwise by subtracting degrees. 

  

Examples:  

 Your Vantage Pro2 anemometer arm is mounted so that it points west, or 270o: 

It is factory-calibrated to "think" this direction is north and will report 0o 

instead of 270o.  The compass would need to rotate counter-clockwise 90o. 

In the Desired Reading column, enter the reading that is 90o less than 

the Current Reading value. 

 Your Anemometer Transmitter Kit anemometer arm is mounted so it points 

southeast, or 135o:   

Therefore it will report 0o instead of 135o . The compass would need to rotate 

clockwise 135 o. 

In the Desired Reading column, enter the reading that is 135o more 

than the Current Reading value. 

 Your Vantage Vue ISS solar panel is facing north (as it would be in the 

Southern Hemisphere), or 0o: 

Therefore it will report 180o instead of 0o . The compass would need to rotate 

180o. 

In the Desired Reading column, enter the reading that is 180o from the 

Current Reading value. 

 Your Vantage Vue ISS solar panel is facing east or 90o: 

Therefore it will report 180o instead of 90o . The compass would need to rotate 

counter-clockwise 90o. 

In the Desired Reading column, enter the reading that is 90o less than 

the Current Reading value. 

 Your Vantage Vue ISS solar panel is facing northwest or 315o.   

Therefore it will report 180o instead of 315o . The compass would need to 

rotate clockwise 135o (315-180). 

In the Desired Reading column, enter the reading that is 135o more 

than the Current Reading value. 

Back to Setup 
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 Temperature Calibration  

 
 

You may add or subtract a constant value to the temperature reading. 

 

1. Select Temperature Calibration from the Setup menu. The Temperature 

Calibration screen appears. 

 

 
 

 

Note: Only TX IDs that have an ISS or an temperature sensor will be available to 

change. 

 

2. The Raw Reading is the uncalibrated reading.  Enter the value you want the 

Envoy8X to report in the Adjusted Reading column.  For example, if you want 

outside temperatures to report one degree higher, enter a value one degree higher 

than the raw reading value. 

3. If you have set a rather long archive interval, such as one or two hours, or if you 

need an average temperature, you may choose to average the temperature over 

the archive period instead of getting one "snapshot" of the temperature. Check the 

Average Temperature Over Archive Period box to average temperature over 

the period. 

4. Click Set to save the settings, Reset to clear the entries, or Cancel to exit without 

saving. 

 

Back to Setup 
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 Humidity Calibration  

 
 

You may add or subtract a constant value to the humidity reading. 

 

1. Select Humidity Calibration from the Setup menu. The Humidity Calibration 

screen appears. 

 

 
 

Note: Only TX IDs that have an ISS or a humidity sensor will be available to 

change. 

 

2. The Raw Reading is the uncalibrated reading.  Enter the value you want the 

Envoy8X to report in the Adjusted Humidity column.  For example, if you want 

outside humidities to report one percent higher, enter a value one percent 

higher than the raw reading value. 

3. Click Set to save the settings; Reset to return to defaults, or Cancel to exit 

without saving. 

 

Back to Setup 
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 Set Alarms  

 
 

Your Envoy8X can be set to sound an audible alarm when weather conditions reach highs 

or lows you set. 

 

 High Outside Temperature 

 Low Outside Temperature 

 High Outside Humidity 

 Low Outside Humidity 

 High Dew Point 

 Low Dew Point 

 High Wind Speed 

 High 10-minute Wind Average 

 Low Wind Chill  

 High Heat Index 

 High THSW Index 

 High Solar Radiation 

 High UV Index 

 High Rain Rate 

 High Flash Flood 

 High Rain for Last 24 Hours 

 High Daily Evapotranspiration  

 
Note: The alarms are set only on the Envoy8X connected on the COM port you have 

selected.  If you have more than one Envoy8X, set alarms for each Envoy8X separately. 

 

 

To set alarms: 

 

1. Select Set Alarms in the Setup menu.The Set Alarm dialog box displays. 
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2. Choose the transmitter: Each type of transmitter you have configured appears on a 

separate tab. On each transmitter type tab, choose the Transmitter ID number of 

the transmitter you want to set alarms for.   

 

For example, if you have a Vantage Pro2 ISS with TX ID 1  and a Vantage Vue ISS 

set to TX ID 3, you can set separate alarms for each.  First, click the ISS tab, select 

TX1 for the Vantage Pro2 ISS.  Set the alarms you want for that ISS's data.  Then 

select TX 3 for the Vantage Vue ISS and set the alarms you want for that ISS's 

data.  

3. When the Envoy8X receives data that meets or exceeds the values you enter, an 

alarm sounds if the Sound Alarm box is checked.  

4. When you have set alarms you want for all the transmitting station data, click Set to 

save the settings.  Click Cancel to exit without saving, or Clear All to clear all 

alarms on the transmitter and exit.  

5. To turn off the alarm, reenter the Set Alarms dialog box (click Set Alarms in the 

Setup menu) and enter a different value or dashes in the alarm field that has been 

triggered. 

6. To see which alarm has been triggered, select Current Readings or Transmitter 

Status from the View menu. 

 

 
 

Back to Setup 
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  Configure Automatic Download 
 
You can set up your system so that data downloads automatically.   

 

Note: The data will be automatically downloaded only when the program is running. If you have 

setup automatic downloads, you should leave the program running.  (You may minimize it.) 

 

1. In the Setup menu, select Configure Automatic Download. 

 

 
 

2. The automatic download configuration dialog box appears.  

  

 
 

 
3. Check the box to turn on automatic download. 

 
4. Check the refresh data box if you would like your browser to automatically refresh.   

 
Note: If you choose a very short interval, the refresh rate may be so long as to overlap the next 

scheduled download and cause that download to be delayed or skipped.  If you are downloading 
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from several sensors and want to set a short download interval, leave this box unchecked and 

refresh the screen manually to avoid missing downloads.  

 

5. Choose a download interval from one minute to 60 minutes.  

 
6. Click Set. 

 

Only new data (since the last download) will be automatically downloaded at each interval.  

The data will be exported to WeatherLink in the same way as if it was manually downloaded 

if a WeatherLink profile has been set up. 
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 WeatherLink Export Profile  

  
 

Use the WeatherLink Export Profile Setup dialog to create export profiles which specify 

how to map your Envoy8x data to the older WeatherLink format.   

Note: Archive intervals of less than one minute are not supported for exporting to 

WeatherLink. (If "second" data is imported, only the first record of the minute is imported.) 

When you download data in the Envoy8X software, an export file will be created from the 

downloaded data that can be imported into WeatherLink Software versions 5.93 and later. 

 

Note: A profile is actually a text file that specifies how the data is to be mapped.  This file is 

saved in the Profiles folder of your program folder.  If your profile name is, "MyProfile", then 

the file saved will be called, "MyProfile.txt".  The export file that is created uses the profile 

name, but adds the ".bin" extension.  If your profile name is "MyProfile", then the export file 

will be called, "MyProfile.bin", and is saved in the Profiles\Export folder of your program 

folder.  In the WeatherLink software choose "Import Envoy8x data", from the File menu to 

quickly import the data into WeatherLink. 

 

1. From the Setup Menu, choose WeatherLink Export Profile. 
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2. The WeatherLink Export Profile Setup dialog box appears. 

 

 

 
3. Click New Profile and give the profile a name in the Profile Name field  You can 

have as many profiles for a given Envoy8x as you need (they each will have their own 

export file). 

 
4. Choose the receiver this profile will be used with in the Receiver Name pull-down 

menu. 

 
5. The labels on the left are the WeatherLink field names.  For each WeatherLink field 

(Inside Temperature, Outside Temperature etc.), you can select what Envoy8X data 

you want to map to that field. 

 
6. Click Save Profile to save the profile.  Now, whenever you download data an export 

file will be written with the new data and can be imported into WeatherLink.  

 
7. Click Close to exit without saving. Click Open Profile to edit an existing profile.  Click 

Delete Profile to delete the profile. 

 
8. You may use this command set up several profiles or delete profiles.   

 

Exporting to WeatherLink 

Once you have saved a profile, the export file will be updated with new data whenever that 
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Envoy8X is downloaded.  It can then be imported to WeatherLink, using the Import to 

Envoy8X command in the WeatherLink software. 

 

Note: To save time, Full WeatherLink Export will not save the data to your database; it 

will only export the data to WeatherLink.  If you want to save all data to the database, as well 

as exporting to WeatherLink choose Force Full Download.  

 

 
 

Back to Setup 
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 File  

 
 

Use the File Menu to download, export or import to a database, or export data to 

WeatherLink. 

 

 
 

Download: Use to download new data since the last download. It will save new data to the 

database and to the export file for WeatherLink. 

Force Full Download: Use to download all the data in the memory, save it to the database 

and to the export file for WeatherLink. 

Full WeatherLink Export: Use to download all the data in the memory and to the export 

file for WeatherLink, but not save to the database. 

Database Import 

Database Export 

Export to Excel: Use to export the data shown in the browser to a CVS or XLS file. 

Exit: Click to exit the Weather Data Transfer Utility program. You may also click the red X 

in the upper right corner of the window, or press the control and x keys on your keyboard. 
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 Download  

 
 

You can download only new data, or all the data in the receiver's archive memory.  Use the 

Download command to download only new data since the last download. It will save new 

data to the database and export to WeatherLink. 

 

You can also set up your system so that data downloads automatically at intervals from one 

minute to 60 minutes.  See Configure Automatic Download for more information. 

 

Note: All downloaded data will be stored in the database, including data that is not selected 

to display in the browser. 

 

Click Download from the File menu to download the data that has been logged since the 

last time you downloaded. 

 

 
 

 
Downloading from more than one receiver: 

 
 

If you have set up more than one receiver, they will all appear in the Receiver Devices 
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field.  However, the data downloaded will be from the receiver currently connected to the 

computer.   

 

If more than one receiver is connected at the same time, the data downloaded will be from 

the the receiver connected to the COM port, as shown in the title bar, that was last used for 

any communication between the computer and the receiver, such as downloading or 

changing something in setup.  (This may NOT be the receiver selected in the Receiver 

Devices field.) 

 

You can see which receiver will be downloaded by selecting Communication Port from the 

Setup menu and choosing the COM port to which the receiver you want to download is 

connected.  (You will need to know which receiver is connected to which port; you can use 

the Receiver Configuration screen to see which receiver is on the current port.) 

 

 
 

See Force Full Download to download all the data stored in the receiver's memory. 

 

Back to File 
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 Force Full Download  

 
 

To download all the data stored in your Envoy8X (including data that has already been 

downloaded) save it to the database and export to WeatherLink, click Force Full 

Download from the File menu. 

 

 

 
 

Back to File 
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 Database Import  

 
 

You can import data from another database into Weather Data Transfer Utility for Envoy8X 

by selecting Database Import in the File menu. 

 

   
 

Select the file you want to import. (It must be a *.zip formatted file.)  

 

Note: When you use the Database Export function, the output file will be a *.zip file and will 

be stored by default in the DatabaseExport folder. 

 

 
 

Click Open to import the file, or Cancel to exit without importing. 

 

Back to File 
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 Database Export  

  
 

You may export data from the Weather Data Transfer Utility for Envoy8X.  The output file of 

this operation will be a *.zip file and will be stored by default in the DatabaseExport folder in 

the WeatherDTU folder.  You can specify a different location.  This file can be imported later. 

 

1. Click Database Export in the File menu. 

 

 

 

2. The Export Data from Database dialog box opens.  

 

  
 

3. Select the receiver from the Receivers pull-down list. 

4. Select the range of dates you want to export.   
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5. Select the location you want to export the data to. (The default is DatabaseExport 

folder.) 

6. Click Export.  A progress dialog box will open.  Click Cancel to stop the export. 

 

 

Back to File 
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 Export To Excel  

  Exporting your data to Microsoft Excel allows you to create graphs, charts, and reports in Excel.  

 

Note: You must have Microsoft Excel installed on your computer to use this feature. 

 

Note: This function exports only the data shown in the browser. 

 

There are two ways to get your data into an Excel file: export all the data in the browser or cut and 

paste specific data.   

 

If you want to export all the data shown in the browser:  

 
1. Click Export to Excel in the File menu, or click the Export to Excel button. 

 

 
 

 
2. The default directory is ExcelExport.  You can change this by selecting another directory in the 

Save in field.   
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3. The file will be saved as a CSV file.  CSV is a comma-delimited text file and can be opened in 

Excel. (Excel is the default program to open this type of file.)  Click Save. 

4. An Excel spreadsheet with your data will open automatically.  

 

If you want to export data from only specific rows or cells, you may use cut and paste.   

1. Select the cells or rows of data you want to export. You can select specific cells using the 

CTRL key.  Select entire rows by clicking in the empty cell in the leftmost column of the row 

you want to select, or click and drag to select a range of cells. 

 

 

2. Hold the CTRL + C keys on your keyboard to copy the selected cells. 

3. Open your Excel file and paste the copied data into it. 

 

Back to File 
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 View  

 
 

Use the View Menu to refresh the screen and see text versions of current readings and 

transmitter status. 

 

 
 

Refresh 

Hide Controls 

Select Data Fields 

Current Readings 

Transmitter Status 

Open Event Log:  Used for troubleshooting 
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 Refresh  

 
 

If you select a different Envoy8X or select different Transmitter IDs, you will need to refresh 

the screen. 

 

Click Refresh from the View menu to refresh the screen.   

 

Or, you can click on the Refresh button. 

 

 
 

Back to View 
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 Hide Controls  

  
 

The top part of the screen below the menu bar that shows the Envoy8X and Transmitter 

details, can be hidden to allow more space for  data.   

 

 
 

 

Click Hide Controls in the View menu, or press the F6 key.  
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To return, click Show Controls in the View menu or press the F6 key. 

 

 
 

Back to View 
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 Select Data Fields  

  
 

The Weather Data Transfer Utility software browser shows data in columns; each column 

shows data from one sensor on one Transmitter ID.  You can select which data to display in 

the browser columns in this window.   

 

1. Click Select Data Fields in the View menu. The Select Browser Data Fields dialog 

box displays. 

 

 
 

 

Data fields for all transmitters appear, organized by ISS, Temperature/Humidity, Wind, 

and Rain transmitting stations; Leaf Wetness & Soil Temperature/Moisture transmitting 

stations; Inside (Envo8X) Data; Raw Data; and Diagnostic Data. 

 

Note: Use Raw Data when one of your Transmitter IDs is reporting data from a 

compatible third-party sensor. Use Diagnostic data for troubleshooting and debugging. 

However, when you use a third-party anemometer and our Universal Anemometer 

Interface, it will behave as if it were a Davis anemometer. 

2. Check the box next to the data field you want to be displayed in the browser.   

 

Note: You may choose to see Diagnostic Data in your browser.  
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If you choose Transmitter Status the column in the browser will show the following codes: 

OK 
At the time of the archive, the transmitter 

was tracked with no error conditions. 

R 
At the time of the archive the receiver was 

trying to resynch (find) the transmitter 

L 

At the time of the archive the receiver was 

lost (not currently being tracked).  It will 

go into the R state at a later time to try to 

find the transmitter. 

B 

The low battery bit was set in one or more 

packets coming from the transmitter during 

the archive interval. 

The number in parentheses following the code is the hex value for the status byte. 

 

3. When you have selected all the data fields you want to see in the browser, click OK.  

You may select all the data fields with the Select All button, or uncheck all boxes with 

the Clear All button.  Click Default to select the default sensors (Outside Temperature 

and Humidity, Wind Speed, Total Rain Amount; Inside Temperature and Humidity, 

Barometer). 

 

Back to View 
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 Current Readings  

 
 

Click Current Readings in the View menu to see the last data received by your Envoy8X.  

The Data will be updated every 10 seconds automatically. 

 

 
 

Back to View 
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 Transmitter Status  

 
 

Click Transmitter Status in the View menu to see the diagnostic status of each transmitting 

station. 

 

 
 

Back to View 
 

 

 Copyright © 2011 - 2013. Davis Instruments Corp. All rights reserved.  



 56 

 
  

 
 

 Database  

 
 

Use the Database Menu to manage databases. 

 

 
 

Connect to Database 

Receiver Devices 
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 Connect to Database  

 
 

Use the Connect to Database dialog box to set up your database.  MS Access is the default 

Database Type.   

For help in deciding which database to use, see Choosing Your Database. 

 

If you are using MS Access:  

For an MS Access database, the full path and name of the database file is required to connect 

to the database. Click the Browse button to select the Access Database (.mdb file) you want 

to connect to. Click Connect. 

  

If you are using MS SQL Server: 

Note: Contact your database administrator if any step below is not clear. 

If MS SQL Server is selected, you will need to choose the Authentication mode for the 

database connection. 

Choose either Windows Authentication mode or SQL Authentication mode. 

 When Windows Authentication mode is selected, your Window login name and 

password will be used in database connection. You will only need to provide the Server 

Name and the Database Name. 

 Server Name: The name of the server on which the Weather Data Transfer 

Utility database is running. 

 Database Name: The name of the database running on the server. The 

database can be empty but it must be created before running the Weather Data 

Transfer Utility. 
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 When SQL Authentication mode is selected, in addition to the Server Name and 

Database Name, you must enter a User Name and Password. The User Name and 

Password should be provided by your DBA. 

 

If you are using MySQL: 

Note: Contact your database administrator if any step below is not clear. 

If MySQL database is selected, enter the following information: 

 

 Server Name: The name of the server on which the Weather Data Transfer Utility 

database is running. 

 Database Name: The name of the database running on the server. The database can 

be empty but it must be created before running the Weather Data Transfer Utility. 

 User Name: The User Name provided by your DBA. 

 Password: The password provided by your DBA. 

 Port: The default is 3306. This usually does not need to be changed. 

Click Connect to connect to the database.  

If the database is connected successfully a dialog box appears and the database connection 

information will be saved and used for the next connection. If the connection fails, you may 

reenter the connection information and try again.  

Note: The Connect To Database dialog can be accessed from the Database menu 

whenever you want to switch to other database. There is no need to close the software.  

Back to Database 
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 Receiver Devices  

  
 

The Receiver Devices command, in the Database menu, lets you see all the Envoy8X 

receivers configured in the database, listed by Receiver ID, with their configured location, 

elevation, latitude, and longitude.  You can use this screen to see the Transmitters IDs and 

transmitter types of your configured receivers.   

 

You can also use it to delete a receiver and all its data by selecting the receiver and clicking 

the Delete Receiver button. 

 

 
 

Back to Database 
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 Technical Support and Contacting Davis  

 
 

You may contact Davis Instruments for technical support or product information using 

any of the methods shown below. 

Technical Support 

Technical Support is available Monday through Friday, 7:00 am to 5:30 pm Pacific Time. 
Or use our web site, fax, fax-back, or email any time day or night. 

510-732-7814 Phone Technical Support 

510-670-0589 Fax Technical Support 

support@davisnet.com Email Technical Support 

Internet Support Includes manuals for all 

products, technical notes, spec 

sheets, installation diagrams, 
and more. 

Other Ways to Contact Davis Instruments 

800-678-3669 Sales (US & Canada) 

510-732-9229 Sales (Outside the US & Canada) 

510-670-0589 Fax 

sales@davisnet.com Email to our Customer Service 

Department 

info@davisnet.com Email for comments or general 

information on Davis Instruments 

Davis Web Site  Davis Instruments' home page on 

the World Wide Web 

E-News Sign Up Sign Up for Weather Club E-

Newsletter 
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 Troubleshooting Guide  

 
 

The following section answers some of the most commonly asked questions about the 

Envo8X and Weather Data Transfer Utility.  

 

Communications Problems 

If you are having trouble establishing communication between the Envoy8X and the 

Weather Data Transfer Utility, start by checking the Envoy8X’s own diagnostics. Follow 

these steps: 

 

Note: The data logger uses non-volatile memory, so you won’t lose any data you’ve 

already recorded. 

 

1. Remove power, both AC and batteries.  

2. Unplug the data logger. 

3. Wait at least two minutes, then plug the data logger back in. Make sure it is 

plugged in firmly and completely.  

4. On power up, you should hear two beeps, each of which occurs when the 

Envoy8X passes one of its diagnostic tests. Each beep follows the previous after 

about a second. The first beep tells you the processor is running. The second 

beep verifies the installation of the data logger. If you do not hear two beeps, 

contact Davis Instruments Technical Support.  

5. If you hear both beeps, see “Troubleshooting Serial Point Communication” for 

instructions on checking your standard serial ports. If this identifies a serial port 

other than the one you selected in station setup, try connecting to the data 

logger again. See “Troubleshooting USB Communication” if you are 

troubleshooting a USB connection.  

 

Note: Generally, if the loopback test identifies a serial port, your PC will be okay. 

  Remove any extension cables that are in the system.  

 

Troubleshooting Serial Port Communication 

   If the port settings or the loop back process identifies a serial port other than the one 

selected, try connecting to the data logger again. 

 

  Check the serial port adapter if using a serial port connection. Use only the blue serial 

port adapter supplied with WeatherLink. Older models, or models not supplied in the 

WeatherLink connection kit, are not compatible. 

 

  Test the serial port using the provided loopback connector. Use the Loopback button 

(as opposed to the Test button) in the Communications Port dialog box to test and 

find the correct serial port connection. If a communications problem exists, it 

determines whether the serial port or the data logger is not communicating properly.  

 

Use the loopback connector (the short cable with a phone jack on one end and a red 

plastic tip on the other) supplied with a serial port data logger.  

5. If necessary, disconnect the cable from the blue serial adapter. 

2. Insert the loopback connector into the adapter. 

3. Select Communication Port from the Setup menu.  

 

The Communication Port dialog box displays. 
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4. Click Loopback. 

The software searches all standard ports and displays the COM port number 

where the loopback connector is located. 

The correct COM port is automatically selected in the Communications Port 

dialog box. If the loopback connector is not found on any COM port, your serial 

port may not be working. If a connection still does not exist or if the loopback 

test identifies the same serial port you have selected, eliminate the following 

possibilities: 

Note: Contact your PC vendor or technical support for more information on 

device difficulties. 

  Hardware device conflict—Check the Device Manager tab in the Windows 

System Properties dialog box to ensure that Windows recognizes the selected 

COM port. Consult your computer’s documentation to see how to access the 

System Properties dialog box. 

  The communication port uses a nonstandard device name—  Weather Data 

Transfer Utility for Envoy8X recognizes serial ports named COM1 through 

COM18 only. 

  Your serial port is defective. 

  The loopback connector is defective. 

Note: See the WeatherLink Online Help if you are troubleshooting a Modem 

connection. 

 

Troubleshooting USB Communication 

  Close the Weather Data Transfer Utility for Envoy8X software. 

  Disconnect the USB cable from the Envoy8X.  

  Plug the cable back into the Envoy8X. 

  Open the Weather Data Transfer Utility for Envoy8X software again. 

  Open the Communications Port dialog box.  

  Click Auto Detect.  If the software finds the receiver, a success message will appear. 

   to verify communication between the station and the software.  

If Auto Detect is unsuccessful, either the station is malfunctioning or the drivers for 

communicating with the data logger have not been installed successfully. To verify 

that the driver is installed, look in the  Windows’ System Properties for Device 

Manager -> Silicon Labs CP210X USB to UART Bridge. If the driver is listed and there 

is still no communication between the station and the computer, call Technical 

Support. If the drivers are not listed, contact Technical Support for instructions on 

installing the necessary drivers. 

  If you are using a third party application that requires the USB connection to emulate 

a com port connection, see WeatherLink Online Help for more information or Contact 

Technical Support. 

 

Program Problems 

? Weather Data Transfer Utility for Envoy8X says “No new data to download” 

but I know there’s data there. What can I do? 
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The Envoy8X system is smart enough to send only data it hasn’t already been sent to 

the computer. So, when you initiate a new download, the program will retrieve the 

first record after the last record shown in the software’s browser window. Reboot and 

reseat the data logger.  

1. Remove power, both AC and batteries. 

2. Unplug the data logger. 

3. Wait at least two minutes, then plug the data logger back in.  Make sure it is 

plugged in firmly and completely. 

4. On power-up, you should hear two beeps, each of which occurs when the 

Envoy8X passes one of its diagnostic tests.  Each beep follow the previous one 

after a second.  The first beep tells you the processor is running. The second 

beep verifies the installation of the data logger. If you do not hear two beeps, 

contact Davis Instruments Technical Support. 

Older data may still be in the data logger, if you have not cleared its memory. To see 

how many of these older records are stored in the logger, create a new station 

(File>New Station) and download the data into this new database. Because there are 

no records stored in the database you just created, WeatherLink will download 

everything it has stored. 

Next, try clearing the archive memory using the clear dialog box. You will lose any 

data not already downloaded in your archive memory, but all of your calibration 

numbers and alarm settings will remain intact. If this doesn’t work, reboot your 

weather station (that is, remove and then restore all power to the station).  

? When viewing data, dashes appear in place of a value for functions other than 

wind direction. Why? 

If no data was recorded by a sensor (for example, the sensor was disconnected or 

radio interference blocked reception), or if bad data was recorded for a sensor (for 

example, the sensor was malfunctioning), the software dashes out the entry rather 

than showing invalid data. You can use the record editor to correct these entries. 
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 Appendix A: Weather Data  

 
 

Refer to this appendix to learn more about the weather variables measured and/or 

calculated by the Envoy8X, by the Vantage Pro2 Integrated Sensor Suite (ISS), and by the 

optional Vantage Pro2 sensors. Each section includes a brief discussion of the weather 

condition and a listing of the various ways in which the unit displays or stores that 

condition.  

 

Note: Some of the weather conditions require an optional sensor in order to measure 

or calculate a value. 

Wind 

The anemometer measures wind speed and wind direction and is part of the Integrated 

Sensor Suite (ISS).  

 

Temperature 

The Envoy8X uses the ISS temperature sensor to measure the outside air temperature. 

A second temperature sensor in the Envoy8X measures the inside air temperature. The 

Envoy’s inside temperature sensor can be replaced with an external temperature 

probe.  You may use the probe to measure any other temperatures that are within the 

sensor’s range, including the temperature of liquids such as water. 

 

Apparent Temperatures 

The Envoy8X calculates four apparent temperature readings: wind chill, heat index, the 

temperature/humidity/wind index (THW Index), and the temperature/humidity/solar 

radiation/wind index (THSW Index). 

Wind chill 

Wind chill takes into account how the speed of the wind affects our perception of 

the air temperature. Our bodies warm the surrounding air molecules by transferring 

heat from the skin. If there’s no air movement, this insulating layer of warm air 

molecules stays next to the body and offers some protection from cooler air 

molecules. However, wind sweeps that warm air surrounding the body away. The 

faster the wind blows, the faster heat is carried away and the colder you feel. Wind 

has a warming effect at higher temperatures. 

 

Note: Wind chill is not calculated above 92° F (33° C). 

 

Wind chill is not stored in archive memory. Wind chill is calculated whenever it is 

displayed. Editing temperature or wind speed values changes the wind chill value. 

 

Note: Envoy8X software uses the Osczevski (1995) equation to calculate wind chill. 

This is the adopted method used by the US National Weather Service. 

 

Heat Index 

The Heat Index uses the temperature and the relative humidity to determine how 

hot the air actually “feels.” When humidity is low, the apparent temperature will be 

lower than the air temperature, since perspiration evaporates rapidly to cool the 

body. However, when humidity is high (i.e., the air is saturated with water vapor) 

the apparent temperature “feels” higher than the actual air temperature, because 

perspiration evaporates more slowly. 

Note: Heat Index is equal to the air temperature at or below 0° F (-18° C) air 

temperature. 
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THW (Temperature - Humidity - Wind) 

The THW Index uses humidity and temperature to calculate an apparent 

temperature like Heat Index, but includes the cooling and heating effects of wind on 

our perception of temperature. 

 

THSW (Temperature - Humidity - Solar - Wind)  

The THSW Index uses humidity and temperature like for the Heat Index, but also 

includes the heating effects of sunshine and the cooling effects of wind (like wind 

chill) to calculate an apparent temperature of what it “feels” like out in the sun. The 

THSW Index requires a solar radiation sensor. 

 

Humidity 

Humidity itself simply refers to the amount of water vapor in the air. However, the total 

amount of water vapor that the air can contain varies with air temperature and 

pressure. Relative humidity takes into account these factors and offers a humidity 

reading which reflects the amount of water vapor in the air as a percentage of the 

amount the air is capable of holding. Relative humidity, therefore, is not actually a 

measure of the amount of water vapor in the air, but a ratio of the air’s water vapor 

content to its capacity. When we use the term humidity in the manual and on the 

screen, we mean relative humidity. 

 

It is important to realize that relative humidity changes with temperature, pressure, 

and water vapor content. A parcel of air with a capacity for 10 g of water vapor which 

contains 4 g of water vapor, the relative humidity would be 40%. Adding 2 g more 

water vapor (for a total of 6 g) would change the humidity to 60%. If that same parcel 

of air is then warmed so that it has a capacity for 20 g of water vapor, the relative 

humidity drops to 30% even though water vapor content does not change. 

 

Relative humidity is an important factor in determining the amount of evaporation from 

plants and wet surfaces since warm air with low humidity has a large capacity to 

absorb extra water vapor. 

 

Dew-Point 

Dew point is the temperature to which air must be cooled for saturation (100% relative 

humidity) to occur, providing there is no change in water vapor content. The dew point 

is an important measurement used to predict the formation of dew, frost, and fog. If 

dew point and temperature are close together in the late afternoon when the air begins 

to turn colder, fog is likely during the night. Dew point is also a good indicator of the 

air’s actual water vapor content, unlike relative humidity, which takes the air’s 

temperature into account. High dew point indicates high water vapor content; low dew 

point indicates low water vapor content. In addition a high dew point indicates a better 

chance of rain, severe thunderstorms, and tornados.  

You can also use dew point to predict the minimum overnight temperature. Provided no 

new fronts are expected overnight and the afternoon relative humidity is greater than 

or equal to 50%, the afternoon’s dew point gives you an idea of what minimum 

temperature to expect overnight, since the air can never get colder than the dew point. 

Dew Point is equal to the air temperature when the Humidity is 100%. 

 

Rain 

Vantage Pro2 incorporates a tipping-bucket rain collector in the ISS that measures 

0.01'' for each tip of the bucket. A metric adapter can be installed to measure 0.2 mm 

for each tip of the bucket. Your station logs rain data in the same units it is measured 

in and converts the logged totals into the selected display units (inches or millimeters) 

at the time it is displayed. Converting at display time reduces possible compounded 
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rounding errors over time.  

Four separate variables track rain totals: “rain storm,” “daily rain,” “monthly rain,” and 

“yearly rain.” Rain rate calculations are based on the interval of time between each 

bucket tip, which is each 0.01'' rainfall increment or 0.2 mm.  

 

Barometric Pressure 

The weight of the air that makes up our atmosphere exerts a pressure on the surface 

of the earth. This pressure is known as atmospheric pressure. Generally, the more air 

above an area, the higher the atmospheric pressure, this means that atmospheric 

pressure changes with altitude. For example, atmospheric pressure is greater at sea 

level than on a mountaintop. To compensate for this difference and facilitate 

comparison between locations with different altitudes, atmospheric pressure is 

generally adjusted to the equivalent sea level pressure. This adjusted pressure is 

known as barometric pressure. In reality, the Vantage Pro2 measures atmospheric 

pressure. When you enter your location’s altitude in Setup Mode, the Vantage Pro2 

stores the necessary offset value to consistently translate atmospheric pressure into 

barometric pressure. 

Barometric pressure also changes with local weather conditions, making barometric 

pressure an extremely important and useful weather forecasting tool. High pressure 

zones are generally associated with fair weather while low pressure zones are generally 

associated with poor weather. For forecasting purposes, however, the absolute 

barometric pressure value is generally less important than the change in barometric 

pressure. In general, rising pressure indicates improving weather conditions while 

falling pressure indicates deteriorating weather conditions. 

 

Solar Radiation 

Note: Requires that the Envoy8X listens to station with optional solar radiation sensor 

attached (#6450, included on Vantage Pro2 Plus weather stations).  

What we call “current solar radiation” is technically known as Global Solar Radiation, a 

measure of the intensity of the sun’s radiation reaching a horizontal surface. This 

irradiance includes both the direct component from the sun and the reflected 

component from the rest of the sky. The solar radiation reading gives a measure of the 

amount of solar radiation hitting the solar radiation sensor at any given time, 

expressed in Watts/sq. m (W/m2). 

 

UV (Ultra Violet) Radiation 

Note: Requires optional UV sensor (#6490, included on Vantage Pro2 Plus weather 

stations).  

Energy from the sun reaches the earth as visible, infrared, and ultraviolet (UV) rays. 

Exposure to UV rays can cause numerous health problems, such as sunburn, skin 

cancer, skin aging, cataracts, and can suppress the immune system. The Envoy8X can 

help analyze the changing levels of UV radiation and can advise of situations where 

exposure is particularly unacceptable. 

Caution: Be aware that the UV sensor readings do not take into account UV reflected off 

snow, sand, or water, which can significantly increase the amount of UV to which you are 

exposed. Nor do the readings take into account the dangers of prolonged exposure to UV 

radiation. The readings do not suggest that any amount of exposure is safe or healthful. 

Do not use the UV readings to determine the amount of UV radiation to which you expose 

yourself. Scientific evidence suggests that UV exposure should be avoided and that even 

low UV doses can be harmful. 

 

Envoy8X presents UV readings in two scales: MEDs and UV Index.  

UV MEDs (Minimum Erythemal Dose) is defined as the amount of sunlight exposure 

necessary to induce a barely perceptible redness of the skin within 24 hours after sun 

exposure. In other words, exposure to 1 MED will result in a reddening of the skin. 

Because different skin types burn at different rates, 1 MED for persons with very dark 

skin is different from 1 MED for persons with very light skin. 

Both the U.S. Environmental Protection Agency (EPA) and Environment Canada have 



 67 

developed skin type categories correlating characteristics of skin with rates of sunburn.  

 

 

 

Table A-1: EPA Skin Phototypes 

 

Skin Phototype Skin color Tanning & Sunburn history 

1 - Never tans, 
 always burns 

Pale or milky white; 
alabaster 

Develops red sunburn; painful 
swelling, skin peels 

2 - Sometimes 
tans, usually 
burns 

Very light brown; 
sometimes freckles 

Usually burns, pinkish or red 
coloring appears; 
can gradually develop light brown 
tan 

3 - Usually tans, 
sometimes burns 

Light tan; brown, or 
olive; 
distinctly pigmented 

Rarely burns; shows moderately 
rapid tanning response 

4 - Always tans; 
rarely burns 

Brown, dark brown, 
or black 

Rarely burns; shows very rapid 
tanning response 

 

 

Table A-2: Environment Canada Skin Types and Reaction to the Sun.  

 

Skin Type Skin Color History of Tanning & 

Sunburning 

I White Always burns easily, never tans 

II White Always burns easily, tans 

minimally 

III Light Brown Burns moderately, tans 

gradually 

IV Moderate Brown Burns minimally, tans well 

V Dark Brown Burns rarely, tans profusely 

VI Black Never burns, deep pigmentation 

 Developed by T. B. Fitzpatrick of the Harvard Medical School. More about the Fitzpatrick Skin Types is available in: Fitzpatrick 

TB. Editorial: the validity and practicality of sun-reactive skin types I through VI. Arch Dermatol 1988; 124:869-871 
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UV Dose and Sunburn - Use this plot to estimate the MED dose leading to sunburn. A person with Type II (Environment 

Canada) skin type might choose 0.75 MED as the maximum for the day; in contrast, a person with Type V (Environment Canada) 

Skin Type might consider 2.5 MEDs a reasonable dose for the day. NOTE: the Envoy8X assumes a Fitzpatrick (Environment 

Canada) Skin Type of II. 

 

 

UV Index 

Envoy8X can also record UV Index, an intensity measurement first defined by Environment 

Canada and since been adopted by the World Meteorological Organization. UV Index 

assigns a number between 0 and 16 to the current UV intensity. The US EPA categorizes 

the Index values as shown below. The lower the number, the lower the danger of sunburn. 

The Index value published by the U.S. National Weather Service is a forecast of the next 

day’s noontime UV intensity. The Index value displayed in WeatherLink is the result of a 

real-time measurement. 

 
Table A-3: UV Index 

Index 

Values 

Exposure 

Category 

0 - 2 Minimal 

3 - 4 Low 

5 - 6 Moderate 

7 - 9 High 

10+ Very High 

 

 

EvapoTranspiration (ET) 

Note: Requires optional solar radiation sensor (#6450, included on Vantage Pro2 or 

Vantage Pro2 Plus weather stations).  

Note: If it is receiving data from more than one transmitter with a solar sensor, the 

Envoy8X uses the one with the lowest TX ID number for ET calculations. 

EvapoTranspiration (ET) is a measurement of the amount of water vapor returned to 
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the air in a given area. It combines the amount of water vapor returned through 

evaporation (from wet vegetation surfaces and the stoma of leaves) with the amount of 

water vapor returned through transpiration (exhaling of moisture through plant skin) to 

arrive at a total. Effectively, ET is the opposite of rainfall, and it is expressed in the 

same units of measure (Inches, millimeters). 

The Envoy8X uses air temperature, relative humidity, average wind speed, and solar 

radiation data to estimate ET which is calculated once per hour on the hour.   

 

Leaf Wetness 

Note:  Note: Leaf Wetness is available with the Envoy8X using the optional Leaf and Soil 

Moisture/Temperature station (#6345) with a Leaf Wetness sensor (#6420). 

Leaf wetness provides an indication of whether the surface of foliage in the area of the 

sensor is wet or dry by indicating how wet the surface of the sensor is. The leaf 

wetness reading ranges from 0 (dry) to 15. 

 

Soil Moisture 

Note: Soil Moisture is available with the Envoy8X using the optional Leaf and Soil 

Moisture/Temperature station (#6345) with a Soil Moisture sensor (#6440). 

Soil Moisture, as the name suggests, is a measure of the moisture content of the soil. 

Soil moisture is measured on a scale of 0 to 200 centibars, and can help choose times 

to water crops. The soil moisture sensor measures the vacuum created in the soil by 

the lack of moisture. A high soil moisture reading indicates dryer soil; a lower soil 

moisture reading means wetter soil. 

 

Time 

The Envoy8X has a clock and a calendar for tracking time and date. The calendar 

automatically adjusts for daylight saving time in most of North America and Europe and 

allows manual adjustment elsewhere) and for leap years providing you have entered 

the correct year, latitude and longitude, and daylight savings settings in the Setup 

Mode. 
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  Appendix B: Specifications  

 
 

 

General 

Operating Temperature +0° to +140°F (-18° to +60°C) 

Storage Temperature -22° to +158°F (-30° to +70°C) 

Current Draw 0.90 mA average, 20 mA peak, (plus 0.125 mA for 

each optional wireless transmitter in use) at 4 to 6 

VDC 

AC Power Adapter 5 VDC, 200 mA, regulated 

Batteries 3 AA-cells 

Battery Life up to 4 months, depending on number of TX IDs 

selected 

Connectors Modular RJ-11 

Cable Type 4-conductor, 26 AWG 

Housing Material UV-resistant PVC plastic 

Dimensions (includes antenna) 6.5" x 3.75" x 1.5" (165 mm x 95 mm x 38 mm) 

Weight (with batteries) 0.58 lbs. (0.26 kg) 

Communications  

Transmit/Receive Frequency US Models: 902-928 MHz FHSS, Overseas Models: 

868.0 - 868.6 MHz FHSS 

ID Codes Available 8 

Output Power 902-928 MHz FHSS: FCC-certified low power, less 

than 8 mW, no license required 

 868.0 - 868.6 MHz FHSS. CE-certified, less 

than 8 mW, no license required 

Range: Line of Sight up to 1000 feet (300 m) 

Range: Through Walls 200 to 400 feet (75 to 150 m) 

 

Sensor Inputs 

RF Filtering RC low-pass filter on each signal line 

Sensor Outputs 

Inside Temperature (sensor located in Envoy8X) 

Resolution and Units Current Data: 0.1°F or 1°F or 0.1°C or 1°C (user-

selectable) Historical Data and Alarms: 1°F or 1°C 

(user-selectable) 

Range +32° to +140°F (0° to +60°C) 

Sensor Accuracy ±1°F (±0.5°C) up to 110°F (43°C), ±2°F (±1°C) 

over 110°F (43°C) 

Update Interval 1 minute 

Current Data Instant Reading (user adjustable); Daily and 

Monthly High and Low 

Historical Data Hourly Readings; Daily and Monthly Highs and 

Lows 

Alarms High and Low Thresholds from Instant Reading 

Barometric Pressure (sensor located in Envoy8X) 

Resolution and Units 0.01" Hg, 0.1 mm Hg, 0.1 hPa/mb (user-

selectable) 

Corrected Range 26.00" to 32.00" Hg, 660.0 to 810.0 mm Hg, 

880.0 to 1080.0 hPa/mb 

Uncorrected Range 18.00" to 33.50" Hg, 457.0 to 850.0 mm Hg, 
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592.0 to 1130.0 hPa/mb 

Elevation Range -1500' to +15,300' (-460 m to 4670 m) 

Uncorrected Reading Accuracy ±0.03" Hg (±0.8 mm Hg, ±1.0 hPa/mb) (at room 

temperature) 

Sea-Level Reduction Equation Altimeter 

Equation Source NOAA 

Equation Accuracy ±0.01" Hg (±0.3 mm Hg, ±0.3 hPa/mb) 

Elevation Accuracy Required ±10’ (3m) to meet equation accuracy specification 

Overall Accuracy ±0.04" Hg (±1.0 mm Hg, ±1.4 hPa/mb) 

Trend (change in 3 hours) Change ±0.6" (2 hPa/mb, 1.5 mm Hg) = Rapidly 

Change ±0.2" (.7hPa/mb, 0.5 mm Hg)= Slowly 

Trend Indication 5 position arrow: Rising (rapidly or slowly), 

Steady, or Falling (rapidly or slowly) 

Update Interval 1 minute 

Current Data Instant, 15-min., and Hourly Reading; Daily, 

Monthly, High and Low 

Historical Data 15-min. and Hourly Reading; Daily, Monthly Highs 

and Lows 

Alarms High Threshold from Current Trend for Storm 

Clearing (Rising Trend 

Low Threshold from Current Trend for Storm 

Warning (Falling Trend)  

Rising and Falling Alarms 0.01 to 0.25" Hg (0.1 to 6.4 mm Hg, 0.1 to 8.5 

hPa/mb)  

Inside Relative Humidity (sensor located in Envoy8X) 

Range 1 to 100% RH 

Accuracy ±5% 

Update Interval 1 minute 

Current Data Instant (user adjustable) and Hourly Reading; 

Daily, Monthly High and Low 

Historical Data Hourly Readings; Daily, Monthly Highs and Lows 

Alarms High and Low Threshold from Instant Reading 

External Temperature Probe (Optional) 

Resolution and Units 1°F or 1°C (user-selectable) 

Historical Graph Data and 

Alarms: 

1°F or 1°C (user-selectable) 

Range -40° to +150°F (-40° to +65°C) 

Sensor Accuracy ±1°F (±0.5°C) typical 

Update Interval 62.5 to 75 seconds 

Clock 

Resolution 1 minute 

Units Time: 12 or 24 hour format (user-selectable) 

Date: US or International format (selectable) 

Accuracy ±8 seconds/month 

Adjustments Time: Automatic Daylight Savings Time (for users 

in North America and Europe that observe it in 

AUTO mode, MANUAL setting available for all other 

areas) Date: Automatic Leap Year 

 
 

 Copyright © 2011 - 2013. Davis Instruments Corp. All rights reserved.  
 

 


